Realizacia hardvéru a softvéru pre NIOS II softcore procesor a pripojenie vlastnej periférie

Uloha: Vytvorte systém na baze hradlovych poli od vyrobcu Altera, v ktorom pouzijete softcore
procesor NIOS II. Hardvérové poziadavky su: ekonomickd verzia NIOSII, 32kB RAM, JTAG,
vystupny port na LED a ¢ita¢ ako vlastna periféria kompatibilna s Avalon zbernicou typu ,,Memory
Mapped Slave®. Pre dant perifériu vytvorte balik zékladnych funkcii v jazyku C pre jej ovladanie.
Vlastna periféria mé byt napisana v jazyku VHDL. Ako vychodzi hardvér pouZijte ,,Altera Cyclone
IIT Starter Board*. Cely systém ma striedavo rozblikat’ dve LED.

Postup rieSenia:
1. Vytvorenie nového projektu v prostredi Quartus II.
1.a File > New Project Wizard ...

New Project Wizard: Introduction x|
The New Project \Wizard helps pou create a new project and preliminary project settings, including the
follawitg:

* Project name and directony

* Mame of the top-level design entity
* Froject files and libraries

* Target device Family and device
* ED4 tool settings

*Y'ou can change the settings for an existing project and specify additional project-wide settings with
the Settings command [Aszignments menu). v'ou can use the various pages of the Settings dialog box
to add functionality to the project.

[~ Don't show me this introduction agairé

< Back I Mext > I Eitizt Stamo

1.b Next >
1.c Dotaznik vyplnite nasledovne:
What is the working directory for this project:
D:\ALTERA\EXAMPLES\NIOS CUSTOM_PER 01
What is the name of the project: NIOS CUSTOM_PER 01
Top level entity: NIOS CUSTOM_PER 01



MNew Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5]

DAALTERANEXAMPLESYWNIOS_CUSTOM_PER_M
WIO5_CUSTOM_PER_OM

MNIOS_CUSTOM_FER_M

1.d Next >

Quartus 1T

1.e Ano

1.f Zdrojové stibory budu pridané neskor a tak pokra¢ujeme Next >



MNew Project Wizard: Add Files [page 2 of 5]

Select the design files you want to include in the project. Click ddd All to add all design files in the
project directony to the project. Mote: you can always add design files ba the project later.

File name: || | Sdd |
File: narne | Tope |Library | Design enty/sy.. [HDL version Add Al |

Remove |

Broperties

Up |
Do |

4| | i
Uger Libraries... |

Specify the path names of any non-default librares.

< Back I Mext > I Firizh Starno

1.g Vyberieme FPGA suciastku: EP3C25F324C6

MNew Project Wizard: Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.

— Target device
= Auta device selected by the Fitter

% Specific device selected in 'vailable devices' list

— Dievice Family — Shaow in Ywvailable device' list
Family: | Cyclone I | Package:  |FEGA -
Devices: IA" j Pir count: 324 =

Speed grade: IE ‘I

v Show advanced devices

I™ | HardCopy compatitle anly

Awalable devices;

| Memar... | Embed... | PLL

I arne | Care w... | LEz | Uszer /...
E : : 16

EP3CA0F324CE 1.2 39600 196

1]

_.1
ME1216 282 4

— Companion deyvice

Hard Eomm
¥ Limit DEF & Béb toHardCopy device resources

¢ Back I Meut > I

Firizh Storno

1.h Next >




1.i Nevyberame simulaciu pre ModelSim, nakol’ko WebLicencia zrejme nepodporuje
tvorbu simula¢nych stiborov a tak kompilacia neprebehne korektne.

Mew Project Wizard: EDA Tool Settings [page 4 of 5] x|

Specify the ather EDA toolz - in addition to the Duartus [ software - used with the project.

— Deszign Entm/Synthesis

T ool nanne:

Fiorrnat: I j

I™ | B this ool automatizally to sunthesize the curent desian

— Sirulation

T ool harne: |<None> j

Fiarrnat: I j

I™ | Biur gate-lesel simulation automatically after compilation

— Timing &nalyzis

T ool nanne: I <Moner

Lef el

Fiarrnat: I

™| Rur this tool automatizally after compilation

< Back I Mext > I Finish Stomo

1.j Next >

1.k Finish
x|

‘when pou click Finish, the project will be created with the following settings:

Project directary:
D:/ALTERAERAMPLES /NIOS_CUSTOM_PER_O1/

Praject name: MIOS_CUSTOM_PER_O1
Top-level design entity: MIOS_CUSTOM_PER_O1
Mumber of files added: 1]

Mumber of uzer libraries added: 0

Device azsignments:

Family name: Cyclone 111

Device: EF3CZEF324CE
EDé tonls:

Design entydsynthesis: <Mone>

Simulation: <Monex

Timing analysis: <Mone>

Operating conditions:
WECIMT voltage: 1.2
Junction temperature range:  0-85 °C

< Back et > Starno




2. Pridanie zdrojovych suborov
2.a Do projektového adresara nahrajte subory z baliku nios_blink src.zip:
kemt custom.vhd (VHDL popis periférie ¢itaca)
NIOS_CUSTOM_PER 01.vhd (Top Level Entita projektu)

=R
Files Mark Commands Met Show  Configuration  Skart Help
B[ B (% e AD R RS S
IEI d v[ [ibm_data] 1 197 940 k of 40 960 D48 k free | 5 | . ID d "I [ibm_data] 1 197 940 k of 40 960 048 k free | 5 | .
+d:\ALTERAAEXAMPLESANIDS _CUSTOM_PER_01\™." 3R ~ « “\NIOS_CUSTOM_PER_01_sourceshnios_blink_src.ziph™.” [Edli
+MName Ext |Size Date Altr Mame |f Ext Size Date Altr
&I <DIR>  01.12.2009 09:56 — &I <DIR> 24.11.2009 07:25
[[J[db] <DIR>  01.12.2009 09:56 [ hello_world c 318 23.11.2009 16:24 -a-
[€]MIDS_CUSTOM_PER.. qpf 1 294 01.12.2009 09:56 -a-- [|KEMT_CUSTOM c 975 23.11.2009 16:15 -a--
[/ NIDS_CUSTOM_PER.. qst 2 522 01.12.2009 09:56 -a-- [ leds c 276 23.11.2009 15:56 -a--
[ kemt_custom h 144 23.11.2009 16:15 -a--
[ leds h 118 23.11.2009 16:16 -a--
wi|kemt_custom vhd 3167 23.11.2009 16:34 -a—-
wHIODS CUSTOM PER.. vhd B27 73112008 0855 5~
Ok /3kin0 72 files, 071 dirls) 3k/5kin2 /7 files
\ALTERAANIOS_CUSTOM_PER_O1_sources> | |
F3View | FAEdt | FS5Copy | FGMove | F7MNewFolder |  F8Delete |  Alt+F4 Exit

2.b V prostredi Quartus II pridajte sibor NIOS CUSTOM_PER 01.vhd do projektu:
Project > Add/Remove Files in Project ...




Settings - NIDS_CUSTOM_PER_01 x|

Cateqgory:
- Files
- Libraries Select the design files you want ta include in the project. Click Add All to add all design files in the
. Device project directory ta the project.
[#- Operating Settings and Conditions
[#- Compilation Process Settings .
Fil : Add
&1 EDA Tool Settings Eile rame: | | L |

Design Enty/Synthesis File name | Tupe |Librany | Design ent/sy... |HOL wers Add Al |
- Simulation MIOS_CUSTOM_... WHDL File <Maone:

- Timing Analysiz Eemove |

- Formal Yerification

i Physical Synthesiz Up |
- Board-Level

- Analyzis & Spnthesis Settings Dawn |

- Fitter Settings ;

- Timing Analyzis Settings Eroperties |

TimeQuest Timing Analyzer
B Classic T iming Analyzer Settings
‘... Classic Timing Analyzer Repol
- dggembler
- Diegign Azzistant
- SignalT ap Il Logic Analyzer
- Logic Analyzer Interface

el
[+

M
[

[#- Simulator 5 ettings
- PowerPlay Power Analyzer Settings
- 55N Analyzer
1| | ¥
4 | _’I 0K | Cancel

2.c OK

Vytvorenie procesora NIOS II a jeho subsystému:

3.a Tools > SOPC Builder

3.b V dialégovom okne vyplnime nazov Top Level Entity pre procesor —
NIOS SUBSYSTEM a preferovany jazyk — VHDL

I Create New System x|

Swstem Name:INIOS_SLIEIS‘r‘STEM

Target HOL: O “Yerilog
& wHDL

Ok Cancel

3.cOK
3.d V prostredi SOPC Builder klikneme na v €asti nalavo na NIOS II Processor a stlaCime
Add



™ altera SOPC Builder - NIDS_SUBSYSTEM.sopc* | _PER_ K =1ol x|

File Edit Module System Yiew Tools Help

System Corterts | System Generation I

;'; Componernt Library Target S

3 ’VDevice Family:ICyclone 1] - l Naihe Source MHzZ add
[#-Bridges and Adapters clk_0 External 50,0 —_—
[#-irterface Protocols Remaye
[H-Legacy Componerts -
[#-Memories and Memory Controller:
[#-Peripherals
[#-PLL Uze | Co...I Mociule Mame Description Clock Baze End
H-UsE
[#-ideo and Image Processing

1 | 2]
4| 4 | ol

Mewy ... | Edit.... | A | Removel Edlit.... | = | S | v | X | Address Map... Fitters... | Fitter: Default

@ Info: Mo errors of warnings.

Exit | Help | 4 Frev | Mext | Generate |

3.e Nasledne bude otvorené okno uréené ku konfiguracii NIOS II. Vyberieme ekonomicku
verziu procesora (najmensia, najpomalsia) Nios II/e a stla¢ime Finish. Zvy$nt konfiguraciu

vykondme neskor.
x|

Nios II Processor

, MMU and MPL E JTAG Debug Module Cuskom Instructions
rCore MNios |l
Select a Hios Il core:
I@ Nios ll/e ONios IIfs ONios IIf
. RISC RISC RISC
Nios Il 32-bit I2-hit 32-hit
Selectar Guide Instruction Cache Instruction Cache
Family: Cyclone Il Branch Prediction Branch Prediction
Hardware Multiphy Hatdweare Multiply
fsystem: 50,0 MHz Hardware Divide Harchweare Divide
cpuick 0 Barrel Shifter
Data Cache
ynamic Branch Prediction
Performance st 50,0 MHz Up to & DMIPS Upta 32 DMIPS Up to 57 DMIPS
Logic Usage GO00-700 LEs 1200-1400 LE= 1400-1500 LE=
Memory Usage T M3Ks (or equiv.) Twvo M3Ks + cache Three MSKs + cache
IR IEmbedded Multiplisrs LI I™ Hardiware Divide
Reset Vectar: Memory: | LI Offset: IDxD
Exception Wector, Memory: | LI Offset: IDxZD
= Inciude timil
Only include the MU wwhen using an operating system that explicitly supports an MU
Fast TLE Miss Exception Vector: Memory ﬂ Oftset: ngg
I~ Inciude MRL

‘Warning: Reset vector and Exception vector cannot be set until memary devices are connected to the Mos || processor

Cancel | = B_ackl Next = | Finish |




3.f Priddme pamdt’ RAM: Memories and Memory Controllers > On-Chip > On-Chip
memory (RAM or ROM) a stlaSime add

W Altera SOPC Builder - NIDS_SUBSYSTEM.sopc™ (D ALTERALEXAMPLESNIOS_CUSTOM_PER_01%NIOS SUESYSTE = | Ellil
File Eclit Module System “ew Toolz RNiosl Help

System Cortents | System Generation

Q Component Library 1= T Closk Setings
Mioz Il Processar ’7Device Family:ICyclone I vI Mame Source MHz Add
Bridues and Adapters clk_0 External 50,0 ——
rterface Protocals REmoyE
Legacy Components
El-temaries and Memoary Controllers
[+ Db,
[#-Flash Use |Conne... Maodule Mame Dezcription Clock Baze
EH-0n-Chip v B cpu_d Moz Il Pracessor
@ Avalon-=T Dusl Clock FIFO instruction_master Avalon Memary Mapped Master clk_0
Ayalon-5T Mutti-Channel Shared b a data_master Avalon Memary Mapped Master Ing
2 Avyalon-5T Round Raobin Schedule jtag_debug_module Avalon Memary Mapped Slave 0xc000008(
o Avalon-5T Single Clock FIFC
on-Chip FIFC Memory
FE-SDRAM
[+-ER A
4], Davikarals i
4 il
A K | o
e, | Edit... | Add... | Remove | Eciit.. | = | ) | v | = | Address Map ... | Fitters... Fitter: Default

2 To Do cpu_B: Mo reset vector has been specified for this CPU. Please parameterize the CPUto resolve this issue
2 To Do cpu_D0 Mo exception vectar has been specified for this CPU. Please parameterize the CPU to resolve this issue
& Warning: cpu_ Reset vector and Exception vector cannot be set urtil memory devices are connected to the Mios | processzar

Exit | Help | 4 Erey | Mext » | Generate |

3.g Nasledne bude otvoren¢ konfiguracné okno pre pamaét’, kde nastavime jej vel'kost na
32kB a stlac¢ime Finish.



On-Chip Memory
Mogacers’ (RAM or ROM) ﬁboutl Documentation

~Mermaory type

5 RAM (Wiitable) " ROM (Reac-only)

r Dual-port access

Read During Wite Mods: IDONT CARE 'I

Block type: Auto -
¥ Initislize memary content

Memory will be inftislized from onchip_memaory2 0 hex

Size
Drata swvicth: 52 -
Total memory size: Iﬁ IKBy’tBS LI

I Winirmize memaory block usade (mey impact fmsax)

~Read latency
Slave 51 |1 vl Slave =2 |1 -I

Mernary initialization

I Enable non-defaul infislization file

User-crested intialization file: onchip memory2 0 hex

I Enakle In-System Memory Content Editor feature

Instance ID: INONE

Cancel | Finish |

3.g Upravime zaciato¢nu adresu pamaite v adresovom priestore NIOS II na 0x00010000
dvojitym kliknutim na jej podvodny zaciatok:

™ Altera SOPC Builder - NIDS_SUBSYSTEM.sopc™ { S_CUSTOM_PER_01%NIOS_SUBSYSTEM.s i ] ]
File Edit Module System “iew Toolz Miosll Help

System Corterts | System Generation

- Clock Setting
#3 Component Library = g
2 Mios Il Processar Device Family:lecIone 1l vl Mame Source MHz. aclel
ridges and Adapters clk_0 External 50,0 —

erface Protocols Remoyve
egacy Components
emaries and Memory Controllers

DMA
‘Flash Use |Conne... fadule Mame Description Clock Base
v B cpu_0 Mioz | Processor
@ Avalon-ST Dual Clock FIFO instruction_master Avalon Memory Mapped Master clk_0
- Avalon-ZT Multi-Channel Shared b data_master Avalon Memory Mapped Master IRQ O
@ Avalon-3T Round Robin Schecule ] jtag_debug_madule Avalon Memary Mapped Slave 000000800 |0

' Avalon-5T Single Clock FIFO E onchip_memory2 0 |On-Chip Memory (RAM or ROM)
+ On-Chip FIFC Mermary n Mem pe 5

10001 0000 034

“SDRAM
“SRAM

], Dewinbarals =
= ID b ! I j—I

| " | -

Mewy. .. | Ediit.... | Add...l Remove | Eciit... | = | N | v | X | Addrezs Map.. | Fitters... | Fitter: Default

) To Do epu_D: Mo reset vector has been specified for this CPL. Please parameterize the CPU to resolve this issue
2 To Do cpu_D: Mo exception vector has been specified far thiz CPU. Pleaze parameterize the CPU to resolve thiz izsue

Ezxit Help 4 Frev Mext |» Generste




3.h Priddme perifériu PIO (Parallel Input / Output) pre pripojenie dvoch LED. Z ponuky
vyberieme: Peripherals > Microcontroller Peripherals > PIO (Parallel Input / Output) a
stla¢ime Add.

™ pltera SOPC Builder - NIDS_SUBSYSTEM.sopc* (D:4ALTERA'EXAMPLES! NIOS_CUSTOM_PER_01',NIDS_SUBSYSTEM.S i ]
File Edit Module System “iew Toolz Miosll Help

System Contents | System Generation

— Clock Setting
g Component Library VTR
e @ pios | Processor Device Family:lecIone Il vl ame Source hiHz 2dd
Bridges and Adapters clk_0 External 50,0 —

rterface Protocols FEMDVE
Legacy Components
temaries and Memory Controllers
[=-Peripheralz
: ehug ancd Performance Use |Conne... Module Mame Description Clock Eaze
isplay 2 B cpu_d Mios || Processor
H-FPGA Periphetals instruction_master Avvalon Memory Mapped Master clk_0
@"M!CFDCDWDHBF Petipherals chata_master Awvalon Memory Mapped haster IRQ O
2 Interval Timer ] ftag_debug_module Avalon Memary Mapped Slave 0300000800 (Ox
& . E onchip_memory2_0 On-Chip Memory (RAM or ROM)
57 an hiel y e ' 000010000 |03

--Muﬂiprocessor Coordination
F-PLL

H-USE

[#-ideo and Image Processing

1 " | -

Mewy. .. | Exlt... | Add...l Removel Edit... | = | =Y | hd | x | Address Map. .. | Fitters... | Fiter: Default

CJ To Do cpu_D: Moreset vector has been specified for this CPU. Please parameterize the CPUto resolve thiz issue
CJ To Do cpu_D: Mo exception vectar has been specified for this CPU. Please parameterize the CPU to resolve this issue

Exit | Help | 4 Frev | Mext |» | Generate |

3.1 Nasledne bude otvorené konfiguracné okno. Upravime $irku vystupu na dva bity. Finish.

“ PIO (Parallel I/0)

About | Documentation

Simnulation

ifidth

Wiclth (1-32 bits) : 2|

rDirection
 Eidirectionsl (tristate) ports
" Input ports only
 Bathinput and output ports

& Qutput ports only

~Output Port Reset Yalue

Reszet Yalue: quu

rOutput Registet

[~ Enable individual bit settingiclearing

Cancel | <§ack| Mext = | Eimish |




3.j Dvojitym kliknutim na NIOS II otvorime konfigura¢né okno procesora. Vyberieme
Umiestnenie Reset Vector a Exception Vector v onchip_memory2 0. Finish.

I Mios II Processor - cpu_0

“ Nios II Processor

Magotars

Parameter

Care Mios I1 Caches and Memory Interfaces

Advanced Features

MU and MPU Settings

Documentation

ITaG Debug Module Custom Instructions

~izore Miog Il

Select a Hios Il core:

|®Nios Il/e
. RISC
Nios Il 32-bit
Selector Guide

Family: Cychone Il
fswy'sten'u: 50,0 MHz

cpuid: 0

Performance at 50,0 MHz Upto & DMIPS
Logic Usage E00-700 LE=
femory Usage Twyo MSKS (or eguiv.]

ONios Ilifs ONios IIff
RISC RISC
32-bit S2-bit

Instruction Cache
Branch Prediction
Hardware Multiphy
Hardware Divide

Up to 32 DMPS
1200-1400 LEs
Two M3K= + cache

Hardware Mutiply: [c e e tiutipliers

LI ™ Harclware Divide

In=truction Cache

Branch Prediction

Hardwware Multiply

Hardware Divide

Barrel Shifter

Data Cache

Dynamic Branch Prediction
Upto 57 DMIPS

1400-1800 LEs

Thiee MSKs + cache

Reset Vector: Metmary: Ionchip_memoryz_tl

Exception Vector:  Memary: | memory2 0

I~ Inciude b

LI Offset: IUxD

Ox0001 0000

w | Offzet: IUx2D

Only include the MU when using an operating system that explicitly supparts an ML

00009 0020

Fast TLE Mizs Exception “ector: Memory:

™ Includs MR

;I Offzet: ngg

Cancel | = Eackl Mext = | Einish |

4. Vytvorenie vlastnej periférie
4.a'V SOPC Builderi v zalozke System Contents kliknite na New.
4.b Otvori sa okno Component Editor s aktivnou zaloZnou Introduction. Pokracujeme

stlaéenim Next >

4.c Teraz je otvorena zalozka, kde mézeme pridat HDL zdrojovy subor pre vlastni

perifériu. Stlacime Add.




(mopen x|

Laok in: |E:| MIOS_CUSTOM_PER_MM ;l ¥ ,_’;'E

150 ol

emt_c Qarm

MIOS_CUSTOM_PER_M
MIOS_CUSTOM_PER_OM .=t
MIDS_CUSTOM_PER_M

E] sopc_builder _log

File name: Ikemt_custom.vhd

Files of type: I'a'" Files

4.d stlatime Open

4.e Po analyze stuboru stlacime Close.

4.f Tlacidlom Next > pokracujeme do zaloZzky Signals.
4.g Tlacidlom Next > pokracujeme do zalozky Interfaces
4.h Vyberieme Associated Clock — clock reset

 Component Editor - kemt_custom_hw.tcl* EI
File Templates
Introduction | HOL Files | Signals Interfaces | component izard |
b Ahout Interfaces
Fy
-7 "avalon_slave 0" [Avalon Memory Mapped Slave) ]
Marme: Iavalon_slave_ﬂ Info |
Type: IAvalon Memory Mapped Slave LI
associted oot [T - |
none
™ Block Diagram
avalon_slave_0
addressC=address [3) o
chipselectCchipsalact [1]
witite_neE—wtite_m [1]
wititedata=twritedata [32]
readdata=readdata [32]
~ Timing
Setup ID
Read Vait |1
Wirite it ID
Hold ID
Units IOy'cIes i l
~ Pipelined Tr s
Read latency ID j
Add Interface | Remove [nterfaces With Mo Signals
2 Warning: avalon_slave I Connection point must have an associated clock.
Q Error: avalon_slave_0: Interface must have an associsted clock.
Help 4 Prev Mext | Finish...




4.1 Pokracujeme tla¢idlom Next > do zdlozky Component Wizard. Vyberieme Group -
Peripherals a pripadne vyplnime zvySok. Pokracujeme stlatenim Finish...

B Cogmponent Editor - kemt_custom_hw.tcl* ll

File Templates

Intraduction | HOL Files | Sianals | interfaces ~ Component Wizard
b About Component VWizard

Falder: ID: WALTERAEXAMPLESWIOS _CUSTOM_PER_01

Clazs Mame: Ikemt_c:ustom

Dizplay Mame: Ikemt_c:ustom

Wersion: |1 il

Group: I Peripherals LI

Description: ICi‘tac:

Crested by: IMichaI “archola

lcon: I

Datashiest URL: |

| Mame Default Yalue |Ed'rtable| Type I Group Tooltip

Parameters:

Add Parameter | Remaove Parameter

Previesw the GLIL.. |

@ Info: Mo errars or warnings.

Help o Prev fext B Firizh...

4.j Komponent ulozime.
5I

9 | Youare about to save kemt_custom 1.0 to:
\"/ D:\ALTERA\ERAMPLES\MICS_CUSTOM_PER_O1

The Following Files will be written into your component's Folder:
kemt_custom_hwe.tcl {component description])

Do yaou wish to save changes before exiting?

{ies, Sawe | Ma, Dor't Save | Cancel

4.k Komponent kemt custom pridame do projektu:



I jltera SOPC Builder - NIDS_SUBSYSTEM.sop
File Edit Module System “iew Toolz Miosll Help

TERA'\EXAMPLES'NIOS_CUSTOM_PER_01%NIOS_SUBSYSTEM.so 10l x|

System Contents | System Generation

= Clock Setting:
g Cotmponert Library T
-9 Miog |l Proceszor Device Fam\ly:lecIone 1] A l Mame: I Saurce I MHz I A
B Bridges and Adapters clic_0 [External 50,0 —
[H-Interface Protocols REmovE

Legacy Components
[#-Memaries and Memary Cortrollers
[El-Peripherals

Use |Conne... Module Natme Description Clock Basze

Debug and Performance
Display instruction_master Avalon Memory Mapped Master clk_0

FPGA Peripherals data_master Avalon Memory Mapped Master Ing O
Microcontraller Peripherals tag_debug_maodule Avalon Memary Mapped Slave 000000800 |0
Multiprocessor Coordination v E onchip_memory2_0  |On-Chip Memory (RAM or ROM)

PLL =1 Avalon Memory Mapped Slave clk_0 0x00010000 |Ox
F-USE v Bl pio_o PIO (Parallel 110}
Widen and Image Processing =1 Avalon Memory Mapped Slave clk_0 000000000 |03

ﬁl | | |

ey Edit... Addd.. | Remove | Ediit... | = | e | 7 = Address Map... | Fitters... | Filter: Default

@ Info: Mo errors o swarnings.

Exit Help 4 Frev Mext | Generate

4.1 Stla¢ime Add
4.m Stlac¢ime Finish

kemt_custom - kemt_custom x|

“ kemt_custom

Megotors” kemt_custom Infa

” Block Diagram

kemt_custom_0
avalon E=ayalon_slave_0
clock M=clock_reset

(Mo parameters)

Cancel | Finizh I

4.n Takto méme vytvoreny NIOS II procesor so vSetkymi potrebnymi perifériami



™ Altera SOPC Builder - NIDS_SUBSYSTEM.sopc™ (| J ,NIOS_CUSTOM_PER_014NIOS_SUBSYSTE

File Edit Module System Miew Toolz Miosll Help

=lolx|

System Contents | System Generation

ehug and Performance

Q Component Library VTR Clock Setting
@ Moz | Processor ’7Devic:e Farily: 1 ame Source hiHz 2dd
ricdges and Adapters clk_0 External 50,0 —
rterface Protocols FEMDVE
egacy Components
ethoties and Memory Controllers
Use |Conne... hodule Mame Description Clock EBaze

izplay instruction_master Avvalon Memory Mapped Master clk_0
PG4 Peripherals chata_master Avalon Memary Mapped Master IRQ O
icrocortroller Petipherals ftag_debug_module Aealon Memory Mapped Slave Oxc00000800 |0z
ultiprocessar Coordinstion 2 El onchip_memory2_0  |On-Chip Memory (RAM or ROM)
B-PLL 51 Avvalon Memory Mapped Slave clk_0 0300010000 |0
F-USE icd Bl pio_0 FIC (Parallel 110)
[#-videa and Image Procezsing =1 Avalon Memory Mapped Slave clk_0 000000000 |Ox
2 E kemt_custom_0 kemt_custom
avalon_slave_0 Ayvalon Memory Mapped Slave clk_0 000000020 |0z
| 1| ]
Mewy... | Exitt... | Addd... | Remove | Edit... | = | — | v | = | Acdress Map... Fiters... | Fiter: Default
Exit | Help | 4 Frey | Mest b | Generate |
=10l x|
File Edit Module System ‘iew Toolz Miosll Help
System Contents ::Sys‘tem Generation
~Dption:
System module logic will be created in %HDL.
™ simulstion. Creste project simulatar files. Feun Simulstor |
~Mios || Tools
Mios Il IDE
#2009.12.01 141218 (%) Making arbitration and system (top) modules. ;I

#2009.12.01 14:19:24 (%) Generating GQuattus symbal for top level MIOS_SUBSYSTEM
#2009.12.01 14:19:24 (%) Generating Symbol DoAALTERAEXAMPLESMNIOS _CUSTOM_PER_M MIOS_SUBSYSTEM bsf

A 2009.12.01 14:19:24 (%) Creating command-line system-generation script: DUALTERAEXAMPLESMIOS _CUSTOM_PER_O1MIOS_SUBSYSTEM_generation_script

#2009.12.01 14:19:25 (%) Running setup for HOL simulstor: modelsim
#2009.12.01 14:19:25 (%) Completed generation for system: MOS_SUBSYSTEM.
#2009.12.01 14:19:25 (%) THE FOLLCWVING SYSTEM ITEMS HAVE BEEN GEMERATED:
SOPC Builder database : DUALTERAEXAMPLESMOS _CUSTOM_PER_01MIOS_SUESY STEM. ptf
System HOL Moclel : DofALTERAEX AMPLESMIOS _CUSTORM_PER_01 MIOS_SUBSYSTEM vhd
System Generation Script | DAL TERAEAMPLESMIOS _CUSTOM_PER_01MIOS_SUESY STEM_generation_script
A 2009.12.01 14:19:25 (%) SUCCESS: SYSTEM GEMERATION COMPLETED.

@ Infa: System generation was successful.
4

Exit | Help | \J Presw | [est P | Generate |

4.p Po uspeSnom vygenerovani systému stlacime Exit a pri vyzve ulozime projekt




5. Kompilécia celého projektu v prostredi Quartus.
5.a Projekt skompilujeme: Processing > Start Compilation
5.b Priradime piny: Assigments > Pin Planner:

clk: B9
nreset: N2
pio0[1]: P12
pio0[0]: P13

& Quartus II - D:/ALTERA/EXAMPLES/NIOS_CUSTOM_PER_01/NIDS_CUSTOM_PER_01 - NIOS € 0] x|
File Edit Wiew Processing Tools  Window
Gl - . .
r::'::d. = - Tap View - Wire Bond
: Cyclone |l - EP3CZ5F324C8H
|E Miode Marie
& B pioo[1..0] outpL . E..-"t'.-EE E’E
o ; pio0[1] aukpL OB @@ m.@@@ @_@_@u .
b g DutpL & [ g e vy W (T4 o G 3 gy @ iy &
< <new node s : %gg gx% @@VO {%\Fgg}}g :
] © | i @@@D@D@@@Z}, e
R [ AANCEEDE0S oMY AL - G
= |8 @ A0 M AN b ﬁ\\/@@ =
"@@@@}{}O WA 2 @@@"
N o ASE ;
k[ K
L@@@E\@Oﬁxx [ﬁ\@@@@@@L
w s 24 SR AT
=] - | NG Telerorora o aoatn u PRrEc
’@@Vf\ a0 ool N\ e
“@@@@@ﬁsé@% e@ e v
rlEEa et h ray R
u K 0 2 G e [ [0 5 & S | v
w Hi B ) o e (B [T T4t o D i Sy |
4] I+ br=Eal
’: Mamed: Ii vl ﬁi Edit: Eﬂ |4 Filter: IPinS; Al j
MNode Marme Direction Location 1)0 Bank VREF Group 1) Skarn &

1 ok Input PIN_E9 i B&_MNO 2.5 Y% (default]

2 ¢ nreset Input PIM_MZ z BZ_T0 2.5 Y (defaulk]

3 4 piod[1] Output PIN_P12 4 B4_MO 2.5 Y {default’
e @ pion[n] Output PIN_P13 _B4_NU 2.5V (default
E 5 = ne nnrde s _Iﬂ
= |4 | ’

T

I .

For Help, press F1

5.c Projekt skompilujeme eSte raz: Processing > Start Compilation
5.d Tools > Programmer, hradlové pole nakonfigurujeme.
5.e Tymto mame hardvér prichystany.

6. Tvorba Softvéru pre NIOS II.
6.a Spustime Start > Programs > Altera > NIOS II EDS > NIOS II IDE
6.b Vytvorime novy projekt: File > New > Nios II C/C++ Application
6.c Nakonfigurujeme Projekt:
Zadame nazov napr.: NIOS CUSTOM_PER
Zadame ciel'ovy hardvér: Nabrowsuejeme .ptf subor vygenerovany SOPC builderom
Vyberieme Blank Project



Nios IT C/C+ + Application

Click. Finish ko create application with a default svwstem library as
O ALTERAEXAMPLES\NIOS CLUSTOM_PER_01\software\NIOS_CUSTOM_PER

Mame: | NIOS_CUSTOM_PER

[ Specify Location

LLocation: | AL TERSESAMPLESYMICS _CUSTOM_PER_01Ysoftware Browse, ., |

—Select Target Hardware.

SIOPC Builder System PTF File: ID:'I,.':'.LTER.':'.'I,EX.':'J‘-"IF'LES'I,I"-.IIOS_CLISTDM_F'ER_D1'I,NIOS_SLIBS\"S' j Browse. ., |

CPU: fepu_n =

—Select Project Template

Elank Project — Descripkion

Board Diagrostics ireates a blank project
Count Binary
Hello Freestanding —Details
Hello MicroC0S-11

f Blank Project creates an emphy project ta which you can add -
Hello World r
Hella Warld Small ey Eelal=,
Memary Test
Simple I;u:ucket Server ;I;i;;r?g:ware excample runs on the Following Mios I hardware
Web S !

BH ServEr - Standard
- Full Featured =

(7) < Back Meset = | Finish I Cancel

6.d Stla¢ime Next >
6.¢ Stlac¢ime Finish

6.f Z baliku nios_blink src.zip skopirujeme vsetky .c a .h subory do:
d:\ALTERA\EXAMPLES\NIOS CUSTOM_PER_01\software\src\

6.g dané subory priddme do projektu: Klikneme pravym tlacidlom na mysi na
NIOS_CUSTOM_PER v zalozke Nios II C/C++ Projects




Nios II C/C++ - Nios I1 IDE

ﬁ altera,components
7 hello_world

17 hello_waorld_0

1T hello_warld_0_syslib
T hello_world_syslib

application,stf
readme. txt
17 NIOS_CUSTOM_PER_D1
T MIDS_CUSTOM_PER_O1_syslin
-5 NIDS_CUSTOM_PER_syslib [NIOS_SUESYS

125 NIOS_CUSTOM_PER

125 NIOS_CUSTOM_PER_syslib

6.h Vyberieme Import...

6.1 Vyberieme General > File system
Impork

Select

Import resources from the local file syskem into an existing project.

= General
E Archive File
" Breakpainks
ﬁ Existing Projects into Waorkspace

4 Y 1

EL preferences
(= Alkera Mios 11
= CICH+

= s
(= Team



6.j Stlacime Next >
6.k Nabrowsujeme zdrojové subory v zlozke, kam boli nahraté v kroku 6.f
Vyberieme vSetky zdrojové subory.

L tmport x|

File system —

Import resources from the local file syskem, | { .-_f

Fraom directory: ID:'l,F'.LTER.ﬁ.'l,EX.ﬂ.l"-“IF‘LES'I,NIOS_CLISTOM_F‘ER_Dlﬁ,suftware'l,src j Browse, ., |

""" [ = sie el world.c
[ KEMT CUSTOM.
@ kemt_custom.h
@Ieds.c
L] leds.h
Filter Types... | Select Al Deselect all
Into Folder: INIOS_CLISTOM_F‘ER Browse. .. |
— Dpions

- Crvervarite exisking resources without warning

™ Create complete Folder struckure

' Create selected Folders only

(7) < Back Text = || Finish I Canicel

6.1 Stlacime Finish
6.m Project > Clean...



x

y Clean will discard all build problems and built states. The next time a build
\-‘(} occurs the projects will be rebuilk from scratch,

" Clean projects selected below

(=

O =5 Mios_CUSTOM_PER_syslib

[¥ Start a build immediatek:

Ok I Cancel

6.n Stlacime OK

6.0 Project > Build Project

6.p Projekt nahrame do FPGA tak, Ze klikneme pravym tla¢idlom na mysi na
NIOS_CUSTOM_PER v zalozke Nios II C/C++ Projects a vyberieme Run As > Nios II
Hardware

6.q LED sa teraz musia rozblikat’

6.r. Program mdzeme ladit’ (krokovat) tak, ze klikneme pravym tla¢idlom na mysi na
NIOS CUSTOM PER v zilozke Nios II C/C++ Projects a vyberieme Debug As > Nios 11
Hardware



